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Getting Started  
Welcome to OmniPresent powered by ConferTel 

 

OmniPresent is a highly interactive web conferencing platform which gives users full control of their meetings 

from start to finish. Follow this guide to learn the basics on setting up and hosting live   meetings. 

To begin using OmniPresent it is recommended that you review our System Requirements and System 

Check to ensure proper compatibility. 
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Sharing  
OmniPresent allows people in your meeting to share various types of content with each other – such as 

audio and video, computer files in almost any format, and even a whiteboard to aid online collaboration. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
In this section, we’ll teach you all about presenting and sharing content inside OmniPresent sessions 
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Using Your Camera  
When first entering a session, you may be asked to approve access to your camera, once approved – you 

should see your camera’s input in the video conference content window. You can change your video settings 

and change the output volumes for each participant separately to create the best possible experience. 
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Adjusting Your Video Preferences  
OmniPresent allows you to modify your video configuration during a session. This can become important when 

adjusting to available bandwidth capacity or changing the video aspect ratio to allow for alternative uses of 

your webcam and those of your audience. 

 
You can adjust your camera and video quality by going into “Preferences” 
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Sharing Your Screen  
Once you’ve entered a meeting room as a moderator or host, you are able to share your screen by clicking on 

either of the two highlighted buttons shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you don’t have the screen sharing plugin installed, a download option will show up. You must install the 

screen sharing plugin to be able to share your screen with other participants in the meeting. 
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Once the screen sharing plugin has been successfully installed, you will be able to select from various 

options: 

 
 
 
 
 
 
 
 
 
 
 
 

• The “Entire Desktop” option allows you to share literally everything that’s showing on your desktop 

• The “Computer Programs” option allows you select a specific program and share it with everyone 

else. 

• The “Selected Windows” option will allow you to select only one window from the ones you have 

already opened in your computer, so you can share only that window with the rest of attendees. (For 

example: you have a Word document open, your browser window and a notepad window active at the 

moment. You click on the “Selected Windows” option and then select the Notepad window in order to 

start sharing it. The only thing that the rest of participants will be able to see during that time on the 

meeting will be your Notepad window. All the other applications that were not selected will show up in 

black). 

 
If you want to stop sharing your screen, you can click on the “Stop” button: 
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Adding and Downloading Files to the  
Media Library  
You can add files by clicking on the Media Library button: 

 

Once you click on the “Media Library” button, an additional bar will show up on the right side of the screen. This 

bar contains the files that you uploaded (“Media Library”) and the files that were shared for download (“Shared 

Files”). 
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Please click on the “Plus” sign so you can start uploading files. Once they are converted, they will show up on 

the Media Library bar. 

 
If you want to allow participants in a session to download a document, please select the file within your media 

library and drag it downwards to the “Shared Files”. This will make a button appear on the bottom of the content 

share synclet with a download link for anyone to use 
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Recording Sessions  
To begin recording your session, click on the Record icon from the main toolbar 

 

From there you will be prompted to name the recording 

 

You can pause your recordings directly from the toolbar. 



CONFERTEL OmniPresent User Guide  
 
 

Page 13 of 46 
 

 
 
 

The OmniPresent File Converter  
OmniPresent’s file converter allows users to upload their files and add them to their Media Library so they   

can be shared with the rest of the participants. When uploading a file, you will see a “loading” bar that tracks 

the conversion progress. This means that the file you selected is being uploaded and converted so that all 

participants can look at it, regardless of which device they are using to join the session. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once the progress bar disappears, you’re ready to share your file with the rest of attendees. You can simply drag 

it to the center of the screen for the rest of participants to see it, or you can drag it to the “Shared Files” area, so 

other participants can download it to their devices. 
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User Roles  
As the organizer of a session or if you have been granted Moderator privileges to the session, you will be able 

to change your participant’s role. 

 
Each of the roles are described below: 

 

• Moderator : Grants “all-access” privileges inside a session. They can activate other participant’s ability 

to share their video & audio, ban users, share files, record sessions, etc. They also have the 

“Workspace” menu available at the top of the window, so they can personalize the workspace and 

bring in new synclets. 

 
• Participants:  They have more limited privileges inside a session. They must request permission to 

broadcast their audio and video and to share files. They do not have the “Workspace” menu available 

at the top of the session window. They just have the “Options” and “Help” menus available. 

 
• Observers:  This is the most limited type of access with even less privileges than that of “participants” 

– they are able to watch and listen to the meeting but not much else. 
 

To learn more on how to change user roles within your session, go to “Control Your Audience”. 
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Phone Only Audio  
Phone only sessions require that all participants dial into a conference bridge, using a toll free number and 

conference passcode. 
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Inside the Session  
The following articles describe some of the features that can give your webinars and online meetings a 

connected media-rich experience, just as if everyone was in the same place. 
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The Workspace  
The Workspace is divided into interactive windows that perform a specific function. These are some of the 

most commonly used windows and buttons: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Video Conference window : It shows the participants audio and/or video broadcasts. 

Participants window : Contains the name of every connected user. 

Chat window : Will contain both public chat and private messages, divided into separate tabs 

Content sharing area : Files that have been uploaded to you Media Library must be dragged to this area so 

that the rest of participants can access them. It also contains the “Share My Screen”, “My Documents” and 

“Whiteboard” options for Moderators. Only the “My Documents” option is available for Participants. 

Top menu bar: “Options”, “Workspace” and “Help” for Moderators and only “Options” and Workspace” for 

Participants. They allow you to configure different areas on the platform. 
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Corner buttons area : For Moderators it includes the “Start my Camera”, “Show Media Library”, “Invite 

Participants”, “Start Screen Sharing”, “Start Recording” and “Notification”  buttons. 

 
For Participants it will include only the “Show Media Library”, “Raise Your Hand” and “Notification” buttons. 

The “Raise Your Hand” button allow participants to request permission to start their broadcasts. 
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Workspace Views  
The WORKSPACE menu allows a moderator to change the look and feel of the Workspace layout. Here, you 

can select one of the predefined views (Conference View, Presentation View or Discussion View) or create 

your own custom layout by selecting which content is visible, moving and resizing the content windows to 

their desired position and then selecting SAVE CURRENT  VIEW. 
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Control Your Audience  
As an organizer or moderator you can view who has joined your session, as well as manage their ‘User   

Role’ i.e. their permissions within the session. You can also invite someone to share their video or even ban 

them out of the meeting room. All these options can be managed through the Participants synclet, which is 

shown and described in the image below: 
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Request to Speak  
If you have been invited to a session and haven’t been assigned to the Moderator role, you may need to 

request permission to start your webcam and audio device from a room moderator. 

 
You can do this by clicking on the ‘Request to Speak’ icon in the top right of the session window. 

This will generate a dialog on the session Moderators’ side where they can allow you to start your webcam and 

mic. 
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Whiteboard  
To activate the whiteboard you will need an empty “Content Share” Synclet, you should have one by default 

whenever you start a session. If you don’t have an empty content share space, open a new one and click on 

“Start Whiteboard”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The whiteboard will show up, along with drawing tools at the top of the screen. Participants will only see the 

whiteboard and what others draw and write on it, but they won’t be able to see the drawing tools. 
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Moderators will have full access. It should look like the following: 

 
After you and the rest of the moderators are done making changes to the whiteboard, you can save the 

drawings you make on the whiteboard as a png image. Simply click on the “X” corner sign located on the 

Whiteboard tab. A pop-up message will show up asking you if you would like to save your changes.    
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Click “Save”. 

 

You can also open a PDF, MS Office file or an image and activate the whiteboard to draw on top of it. To do 

so, start by opening the desired file on a content share synclet using your media library. The Whiteboard 

button will be located at the lower right corner of the screen. Once you click on it, the drawing tools will    

show up at the top of the image or PDF file, just like they do when you start the whiteboard. 
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Chat  
Another means of communicating with meeting participants in addition to using audio and video is the live 

chat feature. This option allows you send messages to all of the participants at once or individually in a 

private chat. You can choose your font color. These options are shown in the graphic below: 
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You can also choose to clear the entire chat history or send the chat log to your email. The image below 

shows all the advanced chat options: 
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Testing Your Connection  
Once in a session, you can check if you have an acceptable internet connection for a media rich online 

meeting by simply moving your mouse cursor to the upper right corner of the user interface. You will see a 

brightly-colored box next to the “Notifications” button. Hover your mouse over the color box to obtain some 

technical details that will help you identify how good your Internet connection is. 

 
 
 
 
 
 
 
 
 
 
 
 
If the color box is green, your Internet connection should be enough to ensure a great collaboration 

experience. If the box is colored in yellow, then your connection may cause video and audio streams to lag 

or stutter. 
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Frequently Asked Questions 
 

Can guests take control over the Moderator’s (host)  computer 
screen?  

Yes, you can allow guests to take control. By default this function is turned off for participants but you can do 

two things: 

 
• Click on the user in the participants list and set his permissions. In Content Share allow him to control 

others screens. 

• Click on the user in the participants list and make him a moderator. Moderators have remote control 

permissions by default. 

 

Which files can I open natively, without converting  them first?  
Files with the following extensions can be opened immediately after upload: swf, jpg, jpeg, png, gif, mp3, 

mp4, flv, m4v, f4v, f4a, f4b, f4p, mov (most), mp4v, m4a, 3gp (most), 3g2 and  aac.  Out of that list you can 

choose to convert the following to a smaller, optimized size: mp4, flv, mov 

 

Other file types can either be uploaded and converted, or just uploaded (and shared with others for 

download, for example). 

 
File types that can be uploaded and converted: 

Office:  doc, docx, ppt, pptx, pps, ppsx, xls, xlsx and also pdf, txt, rtf 

Video:  avi, wmv, mpg, mpeg, asf, asx, fix, mkv, xvid and the file type mentioned in the previous question 

(mp4, flv, mov) 

Audio:  wma, wav, wave, aif, aiff, mpa and ogg 
 

For PowerPoint files 

• Make sure you do not include macros on your slides. For safety reasons we have to disable all 

macros and that should work fine, but there can be cases where the presence of macros will cause 

the conversion to cancel. 

• Make sure you do not embed ActiveX components in your slides (such as external video). This 

causes stability issues with the converter. 

• Make sure you do not rely on external resources, such as CSS. Whilst this should usually not cause 

any issues with the conversion, we have seen cases which made the file nonconvertible. 
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OK thanks, what about other file types? 

 

Other file types can either be uploaded and converted, or just uploaded (and shared with others for 

download, for example). 

 
File types that can be uploaded and converted: 

Office:  doc, docx, ppt, pptx, pps, ppsx, xls, xlsx and also pdf, txt, rtf 

Video : avi, wmv, mpg, mpeg, asf, asx, fix, mkv, xvid and the file type mentioned in the previous question 

(mp4, flv, mov) 

Audio:  wma, wav, wave, aif, aiff, mpa and ogg 

 

The URLs in my PowerPoint presentation are not clic kable, I need my 
viewers to be able to click on links, what can I do ? 
 
When creating your PowerPoint, right click onto the text you want to link and manually reassign the 

hyperlink using the “hyperlink” menu item. If this does not work, make sure to remove any Word Art. 

Applying Word Art will result in this text being rendered as a bitmap image rather than a clickable link. 

Remove Word Art styles by right clicking, then selecting Format > Word Art styles > Clear Word Art. 

 
 

How do I change the default language?  

Changing the language of your account is very simple. Log into your Account Center and click on the 

Welcome drop down menu on the top right. From there click on the My Profile option. From there you will be 

able to select your new language. 
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After a poll, can I see the option that each partic ipant selected during 
the poll, and not only the total percentage?  

Yes, You can. OmniPresent provides you with two options to check poll results: 
 

• Click on “View Votes”. This will show a list indication which option was selected by each participant 

during the session. 

• You can also receive a list of your poll results by email. 
 

The email you’ll receive will contain the poll results, individual options and the corresponding percentage. 
 
 

Are there any keyboard shortcuts for forward and ba ckward 
navigation when sharing a PowerPoint presentation?  

No, we had to disable these controls due to technical difficulties with the permissions model that we apply to 

different users types. 

 
 

Can anybody besides the account holder be appointed  the Moderator 
of a meeting? Can a Moderator set up a meeting?  

Yes, you can have multiple moderators. There are two ways you can promote any attendee. 
 

• If you want to give permission to any participant to be a moderator of a meeting, you can do this while 

scheduling your meeting. 

On the invite screen, right next to the “User” icon in the email field, there is an option “Add to” with a 

drop down box. 

 
• There you can select whether you want to add any participant as a Participant, Moderator or 

Observer.   

 

You can also give Moderator access to any of your participants during the session. Once your 

session starts, click on the name of the participant you want to make a Moderator and select 

the “Role” option. 
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Additionally, you can at any point in time during a meeting, give any user permissions or access to any of 

the tools that are being used at the time of the meeting. This is an advanced feature. To do this, click on the 

name of the participant you want to change permissions for and select the “Permissions” option. You’ll be 

able to turn any individual permission on and off. Once user permissions are edited, you will see a small 

pencil icon next to his/her avatar in the user list. Simply select a role from the drop down to set him back to 

the defaults. 

 
Moderators can control meetings; Participants and Observers cannot. 

 

Someone appointed Moderator cannot set up meetings. Only account holders can. 
 
 

Can screen-sharing or content-sharing be made priva te?  

No, screen sharing or content sharing cannot be made private. 
 
 

Do you encrypt data transmission? Do you use RTMP o r RTMPE? Do 
you use https?  

We use RTMPE (encrypted RTMP) for streams and https for login and files. 
 
 

Do you support application sharing and screen shari ng on Linux?  
Do you have a Linux version of the screen sharing d river?  

Our Linux application sharing driver is currently in experimental status. It requires configuration 
and has limitations such as not allowing selection of individual applications or individual windows 
such as our Windows and OS X versions. That said, sharing the entire desktop works well 
according to some of our Linux customers and we are making this experimental version available 
due to popular demand. 

 
DISCLAIMER: The Linux app share driver is to be considered experimental software. It is not officially 

supported by OmniPresent and not recommended for production environments. Downloading and installing this 

application is entirely at your own risk. 
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Does OmniPresent have any support for Mobile Device s or Tablets?  

Yes, OmniPresent runs on mobile devices and tablets. 
 
Search for “OmniPresent ” in the Apple App Store and Google Play Store to download and install the free app. 

 
Supported iOS devices : 

 

Requires iOS 5.0 or later. Compatible with iPhone (all versions), iPod touch (3rd generation), iPod touch (4th 

generation), iPod touch (5th generation) and iPad (all versions). 

 
Minimum requirements for Android devices: 

 

ARMv7 processor with vector FPU, minimum 550MHz, OpenGL ES 2.0, H.264 and AAC HW decoders 

Android 2.3 and above 

 
If you are having trouble with getting OmniPresent running on your Android device, try installing another 

Adobe AIR based application to isolate the problem. If that app is also causing problems there is an issue with 

Adobe AIR support. Popular AIR-based apps can be found here: 

http://www.appbrain.com/apps/popular/adobe-air/ 

 
 

Does OmniPresent support Polling functions and Surv eys?  

Yes, you can conduct polls and also set your own feedback (Survey) page. 
 

Polls are useful during a meeting if you want instant feedback on what is being presented. Polls can also be 

used at the end of a meeting to find out if participants felt the meeting, content, and presenters were high quality. 

 
An account holder or moderator can use the polling synclet to create questions, or polls, for participants and 

to view the results. Only session hosts and moderator can control polling management and how polls 

appear to meeting participants. Hosts can also cast votes. You can conduct one poll at a time. 

 
If your account has the branding feature enabled, you can set an exit URL. You can send users to a 

webpage where you have set up a survey with a third party tool. 
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Create a Poll: 

 

• Login to the session as a session host or moderator, if the Poll synclet is not displayed, click the 

“WORKSPACE” menu and select Poll to show the Poll synclet. 

• You can add multiple options for answers by checking the box “Allow multiple answers” below the 

question field. 

• Once input is received from the users for a poll, you can then conduct another poll. 

• The polling component allows participants to offer feedback or opinions. 

• First, turn on the Polling component (see directions above for showing/hiding components). 

• Click the Prepare button. 

• To add a question, click and type the question in the input box that appears. 

• To add choices, click in the Answer input box and type each answer choice on its own line 
 

Edit a Poll:   Note: If you edit an open poll, current results are lost. 
• Click Prepare in the bottom-left corner of the Polling synclet. 

• Edit the text. 

• Click Open. 
 

View Poll Results: 
 

As a host or moderator, you can view poll results. These results are updated in real time as participants continue 
to cast or change their votes. All polling results are display in the format of percentages. 

 
The overall responses appear in the Poll pod. To view responses from individual participants, click “View 

Votes”. 

 
To show results of the poll to all your session attendees you need to check the box “Show results to 

everyone” on the polling synclet. 

 
You can also email yourself the results by clicking the menu in the Polling Synclet and selecting email 

results. 

 
Opening an Existing Poll: 

 
Polls that have already been created in a session can be quickly re-opened. When a synclet is minimized/hidden, 
OmniPresent stores all of its information for easy retrieval. 

 
To open an existing poll: 

From the top menu bar, click the “WORKSPACE” menu and select (Checked) Poll.  * 
 

You can also email polling results on your email id. 

To do this click on “POLL” button at the Left hand side top of the polling synclet then select “Email Poll”. it will 

enable a field to enter the email id. By default there will be your OmniPresent account holder’s email id, you 

can change it as per your convenience. Enter your valid email id and click on “Ok”. 
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How can I disable the Pepper Flash plugin in Google  Chrome?  

The Google Chrome browser uses a version of the Flash Player called Pepper Flash. Pepper Flash 
is built into Chrome and is used by default. 

 
There are known issues with Pepper Flash such as audio distortion (robotic sounding, or choppy audio) and 

problems with the synchronization between audio and video, perceivable on the receiving end of the stream. 

 
If the people receiving your stream are complaining of these problems, then it is likely that you may be 

having problems with Pepper Flash. 

 
We recommend that you either: 

 

• use another browser, such as Firefox, Safari or Internet Explorer, or 

• disable Pepper Flash in Chrome and install the publicly available Flash  Player. 
 

To disable Pepper Flash, you can follow the instructions in the following article (courtesy of Newtriks   LTD) 

 
http://newtriks.com/2012/12/01/how-to-disable-the-chrome-pepper-flash-player/ 

 
As the bottom of the article indicates, if you are having troubles disabling the Pepper Flash plugin, you may 

need to rename the Pepper Flash directory so that Chrome cannot find it. OmniPresent will not show you   

the warning after you successfully disable Pepper Flash. 

 
*Note: * it may not be immediately obvious, but the article mentions that the very first thing you should do is 

to download and install the latest Flash Player version from Adobe in Chrome. 
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How can I load YouTube videos in an OmniPresent ses sion?  

• Open your media library. 

• Click the plus icon and select “Add from URL”, then select “Add YouTube video”. 

• A pop-up window will open where you can copy/paste the YouTube URL. The video will then appear 

in your Media Library. 

• Double-click the link from your Media Library or drag and drop it to you content viewer to open it for all 

users in the meeting. Click play to play the video. You’ll have to be an Account Holder or Moderator to be 

able to do this. 

 
 

How can I show the “Registered Users” tab on sessio n login page by 
default?  

To load the “Registered Users” tab by default on session links, just append “/registered” to the URL 
 
You might want to do this when hosting an event and making it easier for your registered users to log in. 

Showing the tab by default will greatly increase the number of users that log in using their accounts vs using 

a guest access. 

 
 

How do I improve the video and audio quality?  

You can bump up the quality of the video feed you are sending by going into “Options” -> 
“Preferences” and selecting the “Camera & Video” tab. If you look in the section “Broadcast Shape 
& Quality” there are a number of quality adjustments you can make there, up to HD video 
standards. 

 
By default we set the medium setting to ensure that most customers can participate without running into 

bandwidth issues at an acceptable quality. 

 
In the “Mic & Speakers” tab you can additionally configure and increase the audio quality. 
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How many attendees can use their camera at the same  time? Are 
there any limitations?  

All the attendees of the session can use their cameras at the same time. For example, if there are 50 attendees 
in a session all can turn on their respective cameras during the session. 
 

The only limitations are the users own bandwidth. Omni-Present will allow you to start as many video 

streams as you like but performance may suffer if bandwidth isn’t available. 

 
 

How does the “Ban User” feature work?  

Moderators can ban a user by selecting the user in the participants module and selecting the ban 
option from the cogwheel menu. A ban can be time limited or for life. 

 
When a banned user attempts to join a session, the moderator will receive a discreet notification. The 

notification provides the moderator with an option to unban the user. 

 
 

How to create folders in the Media Library?  

• Click the + button you use to add files. 

• Select “Add directory” 

A folder will be created in your Media Library and you’ll be able to sort your files. 
 
 

I am not able to access a webinar from outside our network. The 
progress is stuck on the error: “looking for the be st connection 
path”. Please suggest a solution.  

Most likely this is a firewall issue. 
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I’m having trouble getting my file to convert, it s eems the conversion 
fails, what can I do?  

For PowerPoint files: 
 

• Make sure you do not include macros on your slides. For safety reasons we have to disable all 

macros and that should work fine, but there can be cases where the presence of macros will cause 

the conversion to cancel. 

• Make sure you do not embed ActiveX components in your slides (such as external video). This 

causes stability issues with the converter. 

• Make sure you do not rely on external resources, such as CSS. Even though this should not cause 

any issues with the conversion, we have seen cases which made the file unconvertable. 

 
 

In Linux, every time I try to launch the video or a udio, I get a window 
where I am supposed to allow your server to use my camera and 
microphone but the session hangs and I am unable to  click to grant 
permission. Please help.  

This problem is most probably occurring due to a conflict between the general audio input on the 

motherboard and the audio input on your webcam. OmniPresent will, by default, use the webcam audio and 

video settings. In your “Sound Settings” you must cancel the audio input from the webcam and allow it from 

your motherboard, where your microphone is connected. This should solve the conflict. 

 
 

Is it possible to kick a participant out of a meeti ng room?  

Yes, the account holder (green user) and moderators (blue users) can kick another user by hovering over 

that user’s element in the PARTICIPANTS list and clicking the X that appears. Note: moderators cannot kick 

account holders as account holders are higher in the user hierarchy. 

 
 

Is it possible to limit the broadcast of cameras an d microphones to 
broadcast to moderators only?  

No, a stream is broadcasted to all the people in the session. We have added this request to our roadmap. You 

will be able to put users “on hold” in a call, meaning they will temporarily be excluded from any video stream or 

file activity. 
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Is it possible to remove all participants except mo derators from a 
room with a single click?  

No. The closest thing that fits your request is the “Close Session” feature (accessible from the 
OPTIONS menu), which kicks all users except the one who performed the close action. To achieve 
what you want, you would need to kick all non-moderators manually. 

 
However, we have added this request to our roadmap. We imagine you would see an additional pop-up 

asking you if you want to “End session for all users”, “End session for everyone except   Moderators”. 

 
 

Is it possible to work from more than one PC using the same 
login/account?  

Yes, you can use your same account at home, at work and when you travel anywhere in the world. Please 

note you can only log in from one location at a time, we do not allow simultaneous connections from 

different locations using the same account. 

 
 

Is there any option to stop auto chat scrolling?  

Currently, we don’t have such a feature. If your chats are very busy, we suggest you to switch to 

“Discussion View” which offers a much larger chat area and is easier to read. 

 
 

OmniPresent does not load my webcam at all even tho ugh I choose 
the correct camera from the Preferences menu.  

There might be a chance that you are running another software that may be accessing the camera driver. If yes 

then you should exit this other software and refresh your browser to reload OmniPresent and try again. 
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Suggestions to have a seamless session even with ba ndwidth 
problems.  

• Reduce your video quality by using the Camera Preferences 

• If problems persist, turn off video and use audio only. 

• Avoid using Screen Share and use file presentations via the Media Library instead. If you have to use 

screen sharing, share only selected windows or single programs and make the windows smaller if you 

have a very big screen. This will reduce bandwidth usage. 

• Try running a system check on system check to analyze your bandwidth; your students may want to 

do the same. 

 
 

The URLs in my PowerPoint presentation are not clic kable, I need my 
viewers to be able to click on links, what can I do ?  

When creating your PowerPoint, right click onto the text you want to link and manually reassign the 

hyperlink using the “hyperlink” menu item. If this does not work, make sure to remove any Word Art. 

Applying Word Art will result in this text being rendered as a bitmap image rather than a clickable link. 

Remove Word Art styles by right clicking, then selecting Format > Word Art styles > Clear Word Art. 

 
 

The webcam image is mirrored when switching in full  screen mode.  

The mirror image is only seen locally. Remote viewers always see you un-mirrored. 
 
If you wish to flip the image locally you can do that by following these instructions: 

 

• Once you start the broadcast, click on the “Video Conference” option and go to “Camera Settings”. 

• From the “Camera Settings” click on “Camera & Video” and check the “Flip My Image Locally” 

checkbox and apply to make the necessary changes. 

 
 

There seems to be a problem with the time zones. Wh en I select 
GMT+1, it thinks as if we were in GMT+2.  

Your Profile DST (Daylight saving) option is checked; you should uncheck it and see if it shows the correct 

local time 
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Troubleshooting the Application Sharing Plugin  

The plugin won’t launch, why? 

 
The first time OmniPresent launches the screen sharing plugin, you will be presented with a dialog 
that asks you to accept the execution of the plugin. The best thing to do is to put a check inside the 
“remember my choice” checkbox and to press the button to accept the application to launch. On a 
Windows XP computer running FireFox, this dialog looks like this: 

 
If you put a check inside the checkbox and then press “cancel”, FireFox will remember your choice to 

disallow the launch of the plugin. The problem with this is that you will not be shown the dialog again, and 

you will not be able to run the plugin. To fix this, you must type “about:config” into the FireFox address bar, 

and enter “launchappshare” as the filter term. 

 
Then select the launchappshare item and right-click it. From the dropdown menu, select the “Reset” option. 

This will reset the “remember my choice” feature in the dialog, and when you try to launch the application 

sharing plugin, you will now see the original dialog requesting your permission to run the plugin. This time, 

please check the “remember my choice” option and accept the execution of the plugin. 

 
NOTE: this article needs a revision. On my Vista/FF3.0 the about:config does not show launchappshare. 

Instead, I need to look in Tools>Options>Applications (see here), and in the session, I see the following 

dialog. If the exe does not exist for some reason, it will not allow me to press OK. 

 
Uninstalling the Mac OS X screenshare plugin for Om niPresent 

 

• Navigate to your Applications folder 

• Find the App “Application_Sharing” 

• Right click the App and select “Show package contents” 

• Open the Contents Folder 

• Double click the Application “OmniPresentUnInstaller” to run  it 

• Click “Continue” and then “Uninstall” 

• The OmniPresent Application plugin will be uninstalled. 
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We are facing connectivity issues, particularly in establishing the 
connection and loading Synclets. Often this takes c lose to 2 
minutes; sometimes it also throws a timeout error..   

The first connection attempt still cycles through the list of connection configurations, meaning that the first 

connection attempt will still take a long time if the user is sitting in a network that does not allow RTMP. 

To fix this, we require account-wide customization of the order of the connection attempts. It is on our 

roadmap, but we still have to think of the best way to implement it. It is not necessarily in the best interest of 

all conference attendees to have a connection configuration pushed upon them by the account holder. 

RTMPT is much less efficient than RTMP, and we don’t want to force it onto users who are capable of 

connecting via RTMP. The best solution currently is still for system administrators to allow   RTMP. 

 
 

We have a lot of audio problems. The audio cuts and  falls away a lot.  

Two possible reasons for this are lack of bandwidth and low-grade hardware (microphones).In the 
first case, it is important that the moderator take into consideration the bandwidth restrictions of (all) 
the connected clients. If bandwidth is a concern, it is advisable not to engage in bandwidth-intensive 
activities, such as screen sharing. 

 
In the second case, it might be possible that your microphone gain level may be too low. Please raise the gain 

level of your microphone. You can do this directly in the CONFERENCE synclet when you are broadcasting by 

hovering over your video element and adjusting the slider that fades in. You can also achieve this by going to 

Options >> Preferences >> Mic & Speakers and adjusting the slider there. 

 

We require a feature which allows us to add a backg round image to 
the whiteboard which then allows a person to write over the image or 
draw something over the top. Is this a feature that  already exists or 
something you’d be willing to add?  

Yes, the feature you are looking for already exists. You can achieve this by following the steps below: 

 
• Open your Media Library in the session (top bar) and select/add an image file from your computer by 

clicking the black plus button. It will then be added to your “Media Library” and will be converted for 

you. You can open it in the content viewer via double click. 

• Once the image displays, you should click on the “Show Whiteboard” button (small button at the 

bottom right of the content viewer) to activate it. You will see the whiteboard appear on top of the 

image and you are good to go. 
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But remember, the image that a “Moderator” uploads can be seen by all the participants present in the 

session. And to use the whiteboard you have to give the participants these permissions or convert them to a 

moderator. So basically if the image is edited by one participant it will be shared on every participants 

screen. 

 
 

What is the file size limit for documents in the Me dia Library?  

100MB.   
 
 

What is the meaning for each granular permission de scribed on the 
User Guide?  

Moderators of a session can change other users’ role to promote or demote users and thereby 
control the access level they have to certain features in the room. In OmniPresent we call the level 
of access to features “permissions”. A moderator can also modify a particular user’s permissions 
individually. This feature is very powerful and quite advanced. 

 
The permissions menu is available by clicking on an users avatar from the user list and selecting 

“permissions” from the menu.   

 
 

What is the reason for this error: “You are no long er connected and 
please refresh the window for reconnecting”?  

This is likely an indication of network issues. 
 
We advise clients who experience regular disconnections to check their Internet connection; OmniPresent 

cannot maintain a connection if the Internet drops away sporadically. 

 
Often, the problem has to do with a weak wireless signal, in which case we suggest that the client attempt a 

hardwired connection. 
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Why do I get an error message indicating: “We have not detected 
any activity from you in a while. Do you wish to re main connected to 
this session”?  

OmniPresent’s rules for inactivity (idleness) detection are the following: 
 
FOR LIVE SESSIONS, IF: 

 

• user has not been received an incoming stream during the last 10 minutes,  AND 

• session has not been in the recording=true state during the last 10 minutes ,   AND 

• no key/mouse activity during the last 10 minutes,  AND 

• no incoming chat activity during the last 10 minutes,  AND 

• user has not been broadcasting* during the last 10 minutes (OR user is broadcasting* AND has 

been alone for 10 minutes) 

 
FOR PLAYBACK SESSIONS, IF: 

 

• playback is paused or stopped for the last 10  minutes 
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System  Check  
The system check ensures your ability to connect to OmniPresent. Click this link to run System Check: 

https://secure.confertel.net/omnicheck.asp 
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System  Requirements  
Hardware 

 
 

Windows Mac Linux 

1.4GHz Intel Pentium 4 or faster processor (or equivalent) for 
Microsoft Windows XP or Windows 7. 2GHz Pentium 4 or 
faster processor (or equivalent) for Windows Vista 

PowerPC G3 500MHz or faster 
processor. Intel Core Duo 
1.83GHz or faster processor. 

Modern 
processor (1.4 
GHz or faster) 

 
 
1 GB of Ram 

 
 
1GB of Ram 

1 GB of Ram, 
128MB of 
graphics 
memory 

 
128MB of VRAM* 

 
129MB of VRAM* 

128MB of 
VRAM* 

 
*Recommended for GPU hardware acceleration–dependent features. Flash Player will use software mode for 

systems that do not meet the system requirements. 

 
Operating Systems & Browsers 

 
 

 
 
 
Windows 

Microsoft® Windows 7® Microsoft Internet Explorer 7.x, Firefox 4.x, Safari 4.x, Chrome 2.x or higher 
Microsoft® Windows Vista® Microsoft Internet Explorer 7.x, Firefox 4.x, Safari 4.x, Chrome 2.x or 
higher Microsoft® Windows XP® Microsoft Internet Explorer 7.x, Firefox 4.x, Safari 4.x, Chrome 2.x 
or higher 
NOTE: Microsoft Internet Explorer 8 or higher, “Medium” and” Medium-High” default security settings 
supported. “High” security setting not supported. 

 
Mac 

Mac OS X v10.4 or 10.5 (PowerPC) or higher Firefox 4.x, Safari 4.x, Google Chrome 2.x or higher 
Mac OS X v10.4, 10.5, 10.6, 10.7 (Intel) or higher Firefox 4.x, Safari 4.x, Google Chrome 2.x or 
higher 

 
Linux 

Red Hat® Enterprise Linux (RHEL) 5 Firefox 3.x, or higher 
Novell SUSE® 9.x or higher Firefox 3.x, or higher 
Ubuntu 10 or later Firefox 3.x or higher 

Solaris Solaris 10 Firefox 3.x or higher 

 
Flash Player 10.3.183.5 or later (Latest version of flash player recommended) required on all Operating 

Systems. 
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Bandwidth 

 
 

 
AUDIO 

 
VIDEO 

SCREENSHARING & 
REMOTE CONTROL 

From 30kbps upload (100kbps From 100kbps upload (500kbps From 300kbps upload (500kbps 
recommended) recommended, 1MBIT+ for HD) recommended) 
From 30kbps per receiving From 100kbps per receiving stream From 300kbps download 
stream download download (1MBit+ recomended) 

 

While OmniPresent is designed to be bandwidth efficient and performance to degrade gracefully, 

OmniPresent is a broadband platform. For best possible and most reliable experience do not use 

WiFi equipment and use a high-grade, dedicated, low-latency broadband internet access. Use 

our System Check application to test your connection prior to attending a conference. 

 


